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Introduction

Preface

Thank you for using FISAP for Windows for your electronic FISAP processing needs. The U.S. Department of Education (ED) uses the information that you provide in the Fiscal Operations Report and Application to Participate to determine the amount of funds you will receive for each program. 

FISAP for Windows is a PC software package provided to you by ED. It contains the Fiscal Operations Report for program participation during the Award Year July 1, 1997 through June 30, 1998. Federal regulations state that if you spent funds in 1997-1998 or have a Federal Perkins Loan Fund, you must submit a Fiscal Operations Report.

It also contains the Application to Participate for the Award Year July 1, 1999 through June 30, 2000, in the following three campus-based programs:

· Federal Perkins Loan

· Federal Supplemental Educational Opportunity Grant (FSEOG)

· Federal Work-Study (FWS)

You will receive and transmit your FISAP information to ED via the Title IV Wide Area Network (WAN) network using your EDconnect software. 

Using This Installation Guide

Use the instructions contained in this Installation Guide to install the software on your computer or local area network (LAN). See the topic Installation Instructions in this guide for installation information.

This guide also provides you with hardware and software requirements, LAN compatibility issues, and how to get help.

Help

Instead of a paper user’s guide, FISAP for Windows has online help. General help is available from the menu bar and field help is available by pressing the F1 key. From the menu bar, select Help, Using Help for more information.

FISAP Customer Support can be reached by telephone at:

1-800/330-5947 

or by e-mail at:

CPS@NCS.COM
See the topic CPS Customer Service in the online help and this Installation Guide for more information. 

System Requirements

Hardware and Software Requirements

The following hardware and software are required for FISAP for Windows:

· IBM or fully IBM-compatible PC with a 486DX2 66 MHz processor or better

· 16 MB total memory or more

· 300 MB of available hard disk space (depending on the functions you use and how many records you store in your database)

· 3.5" high-density floppy disk drive

· Microsoft compatible mouse

· Hewlett Packard (HP) LaserJet compatible printer.

· MS-DOS version 6.2 or higher (unless using Windows 95 or Windows NT)

· Microsoft Windows version 3.1, Microsoft Windows for Workgroups 3.11, Microsoft Windows 95, or Microsoft Windows NT 4.0 or above

· Consider a quad-speed (or better) CD-ROM drive for other future software distributions

· Consider a tape backup system to store your data

· Monitor and video card capable of standard VGA (800 x 600) resolution (small fonts only). FISAP for Windows was designed in super VGA. You may use a higher resolution than super VGA at your own discretion.

Estimating Hard Disk Space

The following information gives you an estimate of how much hard disk space is required for each ED software product and for certain types of records.

To find out the approximate total space required, add together the amounts shown for each ED-software product and the types of records you are using. You should also take into account other software products installed on your PC. 

Example:

The total space required for 5,000 Direct Loan, ISIR, NSLDS, and Packaging records using all of the software products listed is approximately 70 MB. 

Each software product requires the following space:

Product
Size

EDconnect/NET*CONNECT for Windows
15 MB

EDExpress
16 MB

FISAP for Windows
4 MB

SSCR-32 with 300 records
6 MB

Quality Assurance Program for Windows with 300 records
2 MB

Additional space required per set of 5,000 records (this is in addition to the values listed for the software listed on the previous page):

Record
Size

Direct Loan
6 MB

ISIR
15 MB

NSLDS
4 MB

Packaging
2 MB

Local Area Network (LAN) Server Compatibility

LAN Server Compatibility

FISAP for Windows can be used as stand-alone or multi-user software. It can be run on the following network operating systems: 

· Novell Netware 3.x and 4.x

· Microsoft Windows NT Server

Users should not run the software on peer-to-peer networks such as Arisoft LANtastic or Novell’s Personal Netware.

According to the Microsoft Knowledge Base, some anomalies have been known to occur when using Microsoft Access with the following networks: DEC Pathworks, IBM Lan Server, and Sun PC-NFS. Since FISAP for Windows makes extensive use of Microsoft Access as a database engine, do not use these network operating systems with FISAP for Windows.

LAN Cautions

When multiple users are concurrently updating databases in the FISAP for Windows database, those tabs are locked. Also, certain functions are locked when concurrent access would degrade the system or disrupt a process. 

Examples include:

· The database is locked when the executing function is mass loading records.

· Records are locked when an executing function needs stable data for updating or printing.

· Functions are locked when multiple executions of the functions would destroy the databases. 

LAN Messages

These messages notify users when a locking situation occurs.

LAN Error Message

Condition
<Database> is locked and cannot be accessed at this time.

If the database remains locked after five seconds of continual attempts, the user is returned to the menu bar or to the point prior to execution.

Record in use - Retry later.

If the record remains locked after five seconds of continual attempts, the user is returned to the menu bar or to the point prior to execution.

Function in use - Retry later.

If the function remains locked after five seconds of continual attempts, the user is returned to the menu bar.

See the topic Clear Record Locks in the online help for more information on this subject.

Additional LAN Instructions

From the Netware Server Console prompt, you should enter the following command:

Set Maximum Record Locks Per Connection = 10000
This line should also be added to the AUTOEXEC.NCF file on the NetWare server.

LAN Hardware and Software Recommendations

· IBM or fully IBM-compatible PC with a 486DX2 66 MHz processor or better

· 16 MB total memory or more on each workstation

· 300 MB available hard disk space on the file server (depending on the number of records you will store in your database)

· MS-DOS version 6.2 or higher (unless using Windows 95 or Windows NT)

· Desktop Operating System: Microsoft Windows versions 3.1, 3.11, Microsoft Windows for Workgroups 3.11, Microsoft Windows 95, and Microsoft Windows NT 4.0 or above

· Network Operating System: Novell NetWare versions 3.12 or above or 4.11 or above, Microsoft Windows NT 4.0 or above, or Microsoft LAN Manager

Note: Novell NetWare versions 3.12 and 4.11 are separate products.

· 16 megabit/sec transfer rate on the network for token ring, 10 megabit/sec transfer rate on the network for Ethernet, or the maximum transfer rate your network topology supports 

· Monitor and video card capable of standard VGA (800 x 600) resolution (small fonts only). FISAP for Windows was designed in super VGA. You may use a higher resolution than super VGA at your own discretion. 

Note: For questions regarding any of the listed hardware or software requirements, please contact CPS Customer Service at 1-800/330-5947.

Installation Instructions

Installation Process

This section of the Installation Guide provides you with step-by-step instructions for installing FISAP for Windows. Instructions are provided for both network and stand-alone system installation. 

Depending on the type of install you are performing (network or stand-alone), all installation diskettes may not be required.

Other topics include:

· Install Log creation

· AUTOEXEC.BAT, CONFIG.SYS, and NET.CFG statements

· Uninstall instructions

· How to change your Swap File settings

Follow the prompts the software provides you when installing FISAP for Windows.

Directory Creation

FISAP for Windows is installed to the EDExpress for Windows 1999-2000 program group. The installation process automatically creates the directory FISAP0 for FISAP for Windows files on your local hard disk. 

The C: drive is assumed to be the drive letter of your local hard disk, but you can change the drive letter if necessary. Also, you can use a different name for the directory. 

If you are installing on a LAN, be sure to install to a LAN drive and not to a local drive. 

Installing FISAP for Windows on a Network

Be sure that all Windows applications, including screen-savers, e-mail notifiers, etc. have been closed before you proceed with this setup. 

When you perform a workstation installation, the executable file for FISAP for Windows (FISAP.EXE) installs to a workstation’s local hard drive. The installation modifies all FISAP for Windows program group icons in your Windows Start Menu folders to point to the executable on your local hard drive. 

Installing this file to the workstation’s hard drive rather than the network file server improves the speed and performance of the software because FISAP for Windows uses the combined resources of the workstation and the file server instead of those of the file server alone.

Follow the instructions below to install FISAP for Windows on local area networks.

Instructions for Schools that Already Have FISAP for Windows Installed on a Network File Server

1. Do not use the Network Server installation option for this version of the software. 

The Network Server installation option is now only for users installing FISAP for Windows to a network file server for the first time. Choosing this installation option installs an empty FISAP9.MDB (FISAP database files) on the network file server, overwriting any existing database.

2. Do Full workstation installations on all workstations for this version of the software. 

Choose the Network Workstation installation option, then select Full. The Full option installs the executable file (FISAP.EXE) in a local hard drive directory. It also establishes the workstation’s ODBC (Open Database Connectivity) connection to the FISAP database. The Workstation installation option prompts you for the location of the database installed during the FISAP Network Server installation.

If you have questions, please call CPS Customer Service at 1-800/330-5947.

Instructions for Schools that Are Installing FISAP for Windows on a Network for the First Time

1. First, use the Network Server installation option to install this version of the software. This option installs only the FISAP database (FISAP9.MDB) on the file server, not the FISAP program files.

2. Then, do Full workstation installations on all workstations for this version of the software. Choose the Network Workstation installation option, then select Full. The Full option installs the executable file (FISAP.EXE) in a local hard drive directory. It also establishes the workstation’s ODBC (Open Database Connectivity) connection to the FISAP database. The Workstation installation option prompts you for the location of the database installed during the Network Server installation (step 1).

If you have questions, call CPS Customer Service at 1-800/330-5947.

Instructions for All Schools

If you want to copy the installation diskettes to a file server so you can do workstation installations from the server, follow these steps.

1. Create a disk directory for each diskette received. For example, if you receive five diskettes, then create five directories on the file. Create a directory structure like this one on your server. 

Example:

\Install

\Install\DISK1

\Install\DISK2

\Install\DISK3

\Install\DISK4

\Install\DISK5

Note: The parent directory can have any name, but the subdirectories must be named DISK1, DISK2, etc.

2. Copy the contents of each disk into its corresponding directory on the server.

3. You can now install FISAP for Windows from the file server by running SETUP.EXE from the DISK1 directory on the server instead of carrying the diskettes to each workstation.

If you have questions, call CPS Customer Service at 1-800/330-5947.

Installing FISAP for Windows on a Stand-Alone System

Be sure that all Windows applications, including screen-savers, e-mail notifiers, etc. have been closed before you proceed with this setup. 

Microsoft ODBC (open database connectivity) Setup will fail if any of these applications are still running.

You can install FISAP for Windows using one of three options:

· Full. Use this option when you are installing FISAP for Windows for the first time. It overwrites all existing database (*.MDB) and program files (*.EXE files) in your FISAP0 directory.
Warning: Use caution when using the FULL install option. The program will remove/erase ALL your existing FISAP database (*.MDB) and program files (*.EXE files) in your FISAP0 directory.

· Upgrade. Use this option only if you have already installed a full version of FISAP for Windows for this processing cycle. This option updates only program files (*.EXE files) and leaves your current database intact.

· Custom. If you have already installed a full version of FISAP for Windows for this processing cycle, you can use this option to replace executable program files, ODBC files, HELP, and/or the FISAP database. This option leaves all other system settings intact.

You can reset the FISAPADM user ID and password during a Custom installation. Click Update Database as the component you want to install. Then, the first time you use FISAP for Windows after performing the Custom installation, you will see the Update Database box. Click Reset FISAPADM.

Windows 3.1 or 3.11

1. Turn on your computer and start Microsoft Windows.

2. Insert Diskette #1 in the A: drive.

3. Select File from the Windows Program Manager menu bar.

4. Select Run from the File pull-down menu. 

5. Type a:setup at the command line and click OK. The software is installed to the default directory C:\FISAP0 unless you choose another location. 

6. Insert diskettes in numerical order and click OK when prompted.

FISAP for Windows asks you a series of questions during the installation. Each question has a default answer. 

If the default is correct, click Next in response to each question. 

or

If not, type the correct answer and click Next. 

When it is finished installing the files for FISAP for Windows, the installation program adds the icons to your Program Group in the EDExpress for Windows Program Manager window.

Windows 95 or Windows NT

1. Turn on your computer and start Microsoft Windows.

2. Insert Diskette #1 in the A: drive.

3. Select Start from the Task bar.

4. Select Run from the Start pop-up menu. 

5. Type a:\setup at the command line and click OK. The software is installed to the default directory C:\FISAP0 unless you choose another location. 

6. Insert diskettes in numerical order and click OK when prompted.

FISAP for Windows asks you a series of questions during the installation. Each question has a default answer. 

If the default is correct, click Next in response to each question. 

or

If not, type the correct answer and click Next.

When it is finished installing the files for FISAP for Windows, the installation program updates your Start menu. It will not, however, create desktop icons/shortcuts or update them if they have already been created. 

Install Log

Each time an installation is performed, an Install Log is created. The information that will be tracked is the product and version number, type and nature of the install, drive/directory, date, and time of install. This file is named INSTALL.LOG and is located in your C:\FISAP0 directory.

Example:


<APP NAME>
FISAP for Windows

<VERSION>
1.x

<TYPE>
FULL: Install everything.

<SUMMARY>
New release for ‘99-00 cycle

<TARGET>
C:\FISAP0

<DATE>
08-19-98

<TIME>
08-36-54

AUTOEXEC.BAT, CONFIG.SYS, and NET.CFG

The software can modify your CONFIG.SYS files automatically. If you do not want FISAP for Windows to modify this file, select the appropriate option and click Next. 

To modify your CONFIG.SYS file independently at a later time, add these statements to your file:

Files = 120
(or greater than 120)

Buffers = 32
(or greater than 32)

If you are running FISAP for Windows on a Novell Server, then your NET.CFG file should contain the following statement:

File Handles = 120
(or greater than 120)

For Windows 3.1 and 3.11 Users

For Windows 3.1 or 3.11 users, FISAP for Windows will install the VSHARE.386 file if the file is not present. The VSHARE.386 file will be set up in the SYSTEM.INI (386 Enhanced) file’s section.

Note: Remember to reboot your computer when done.

Uninstall

After you have installed FISAP for Windows, you will see an Icon for the Uninstall utility. By double-clicking on Uninstall, the utility deletes all icons, all executable files, all DLLs, and the entire database for the version of FISAP for Windows you have installed. If FISAP for Windows is installed on a LAN, the Uninstall utility will only delete the FISAP for Windows icons.

To uninstall FISAP for Windows:

1. Double-click on the Uninstall icon.

A prompt asks if you are sure that you want to completely remove the application and all of its components.

2. Click the Yes button.

3. Click OK.

Changing Your Swap File Settings

Windows 3.1 or 3.11 uses swap files to improve the way your computer uses memory while you are in Windows, which in turn improves system performance. Swap files can be temporary or permanent. For maximum performance from FISAP for Windows, your swap file setting for Windows should be set for a permanent swap file and use 32-bit disk access (also 32-bit file access if running Windows for Workgroups 3.11). For simplicity, users can also select a  temporary swap file.  Before you install FISAP for Windows, you should review your swap file setting. 

To change your swap file setting to Temporary from the Windows Program Manager:

1. Open the Main group or the group where your Control Panel icon is located.

2. Double-click the Control Panel icon.

3. Double-click the 386 Enhanced icon.

4. Click the Virtual Memory button. Look at Type to see if your swap file is currently set to Permanent (using BIOS) or Temporary (using MS-DOS). 

5. If the setting is Temporary (using MS-DOS), click OK until you return to the Program Manager window. You are ready to install FISAP for Windows.

6. If the setting is Permanent (using BIOS), continue with step 7 below.

7. Click the Change button.

8. Click the down arrow in the box next to Type and select Temporary. 

9. Click OK.

10. Restart Windows and proceed with installing FISAP for Windows.

To change your swap file setting to Permanent from the Windows Program Manager:

1. Open the Main group or the group where your Control Panel icon is located.

2. Double-click the Control Panel icon.

3. Double-click the 386 Enhanced icon.

4. Click the Virtual Memory button. Look at Type to see if your swap file is currently set to Permanent (using BIOS) or Temporary (using MS-DOS). 

5. If the setting is Permanent (using BIOS) and 32-bit disk access (also 32-bit file access if using Windows for Workgroups) is checked, click OK until you return to the Program Manager window. You are ready to install FISAP for Windows.

6. If the setting is Temporary (using MS-DOS), continue with step 7.

7. Click the Change button.

8. Click the down arrow in the box next to Type and select Permanent.

9. Check the box next to 32-bit disk access (also check 32-bit file access if using Windows for Workgroups).

10. Click OK.

11. Restart Windows and proceed with installing FISAP for Windows.

Getting Started

Logging In for the First Time

Each time you start FISAP for Windows, you must enter a valid user ID and password. FISAP for Windows requires user IDs and passwords for system security.

The first time you use FISAP for Windows, enter FISAPADM for both your user ID and password. FISAPADM is the user ID and password included with FISAP for Windows. You will then be prompted to enter a new user ID and password. 

Follow these steps to log in to FISAP for Windows for the first time.

To log in and establish your new user ID and password:
1. The first time you use FISAP for Windows, enter FISAPADM for both your user ID and password. 

FISAPADM is the user ID and password included with FISAP for Windows. 

2. Press Enter or click OK.
You will be prompted to enter a new User ID and Password.

3. Press Enter or click OK.
4. On the next screen, enter a New User ID, Password, and Verify password.

· Up to eight (8) alphanumeric characters may be entered.

· The Password and Verify Password must be the same.

5. Press Enter or click OK.
FISAP for Windows will indicate that the updates have been saved.

6. Press Enter or click OK.  

After you enter your user ID and password, a message box may display any messages, warnings, or errors. 

Getting Help

Review Installation Instructions

Review the installation instructions again. See if you perhaps left out a step. Try the installation process again.

Become Familiar with Your PC

Display your system information such as your AUTOEXEC.BAT file, CONFIG.SYS file, and memory information. Refer to your MS-DOS or MS-Windows manual for instructions. 

If you have completed the FISAP for Windows installation, click System Information from the Help menu. Compare this information to the required configurations listed at the beginning of this section. You may need to upgrade your equipment or change your files. 

You may also want to run Microsoft’s System Diagnostic (MSD.EXE) program. Refer to your MS-DOS manual for instructions.

Contact Your System Administrator

Your institution or organization may have additional instructions for your PC. For example, you may get an error if you are trying to install the software to a drive for which you do not have access.

FISAP for Windows Online Help

Using Help is simple. You can get help by any of the following methods:

1. From the Help menu, choose a help command.

2. Choose the Help button available in many dialog boxes.

3. Use the keyboard to select an item on a menu, and then press F1 to see a description of the item.

4. Select a dialog box option or command, and then press F1 or click the Help button to move directly to an explanation of the option.

5. Use the Context Help Toolbar button to obtain help on menu options and other Toolbars.

Using Windows 3.1

Complete the Windows tutorial that comes with Windows 3.1. To access this tutorial, follow the steps listed below: 

1. Select File from the Windows Program Manager menu bar.

2. Select Run from the File pull-down menu.

3. Click the Browse button.

4. Highlight wintutor.exe and click OK. You will see this file displayed in the Command line.

5. Click OK.

Using Windows 95

Windows 95 comes with an online tour that describes how to use Windows 95. To access this tour, follow the steps listed below.

1. Select Start from the Task bar.

2. Select Help from the Start pop-up menu.

3. Select the Contents tab.

4. Highlight Tour: Ten minutes to using Windows.

5. Click the Display button.

CPS Customer Service

If you need technical support, call CPS Customer Service at:

800/330-5947
Representatives are available to assist you between 7 a.m. and 7 p.m. (CT), Monday through Friday, excluding holidays. 

You may also send your inquiries via the Internet to CPS at:

CPS@NCS.COM
The CPS Voice Response System has phone routing set up to assist you in designated areas. When you call 800/330-5947, you will be asked to enter the last 5 digits of your Title IV WAN User ID. 

Example:

For TG50001, enter 50001

For TG60001, enter 60001
You will then be presented with a menu of options. 

Choose the area appropriate to the information or assistance you need:

Menu Option
Description

1
CPS Automated Customer Service Center is an automated system through which you can check the status on batches and applications, request faxable materials and information, and obtain other needed data, such as reject, comment, and assumption code definitions.

2
Application Processing – Representatives assist you with  installation and software questions.

3 
Direct Loan – Representatives assist you with installation and software processing issues. 

Representatives also assist you with questions on the Direct Loan Technical Reference.

4
Pell Payment – Representatives assist you with installation and software questions.

5
SSCR – Representatives assist you with installation and software questions. 

6 
Quality Assurance Program for Windows – Representatives assist you with installation, software, and program questions.

7
 Packaging – Representatives assist you with installation and software questions.

8
 FISAP for Windows – Representatives assist you with  installation, software questions, and technical issues. 

When you call CPS Customer Service, you should be at your computer and prepared to provide the following information:

· The version of FISAP you are using (under Help/About ...).

· The type of hardware/network you are using (including total RAM, version of Microsoft Windows, other running applications, LAN type if applicable, available disk space, type of memory management being used, etc.).

· The exact wording of any error messages you have received, as they appeared on your screen.

· A detailed description of the utility or function you were running when the error occurred, what software module or package you were working in (Application Processing, Packaging, Direct Loan, Pell, FISAP, QAP, or SSCR-32), and the steps you took to get to that utility or function.

· A description of any resolution steps you took prior to calling.
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